
AcroTEX.Net

The artthreads Package

Creating article threads for multi-column
documents

D. P. Story

Stop! Before you read this documentation, take a mo-
ment to change your preferences: On your menu system if
Adobe Acrobat/Reader, select Edit > Preferences > General,
and clear the checkbox for the item named Make Hand tool
select text & images, as listed under Basic Tools on that
dialog box. (Ctrl+K or Command+K is the shortcut to the
Preferences dialog box on Windows and Mac OS, respec-
tively.) This makes reading an article thread much easier.
Look for the hand icon with a down arrow on it. DPS
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1. Introduction

2. Navigati
Through the commands of the artthreads
package, you can create article threads, a
concept/feature of Adobe Reader/Acrobat
that has been around since the product’s
beginning. The use of article threads typ-
ically only makes sense in a document in
which the text is in a multi-column format,
or, perhaps, a single narrow column.

When a document uses a multiple col-
umn format, it is often difficult, or at the
very least inconvenient, to read it. When
document page is fit into the viewing win-
dow, the text may be two small to read.
This requires the reader, that’s you, to ad-
just the magnification (zoom) level of the
ng an article thread
page to fit a column of text comfortably in
the application window. Once the column
is fitted, additional navigation is needed to
move the window view down one column,
then up to the top of the next column.
Think of trying to read a digital newspa-
per with many columns. Such navigation
is tedious and distracts from reading the
information begin presented.

Set the article threads after the com-
position of the document is completed.
The method of setting the threads is very
visual not automatic as in the threadcol
package of Scott Patkin.
Perhaps you noticed the ‘Intro’ button on
exhibit in this previous section or the ‘Nav-
igate’ button in this section as well. Click-
ing these buttons reveals the Article panel
in the left-hand navigation pane. Listed
there are all the articles created for this
documentation. Right-clicking on any of
the listed article names brings up a context
menu; select Read Article to begin reading
or choose Properties to see the thread info,
which (may) include the title, author, sub-
ject, and keywords.

Begin an article thread. There are two of
ways to begin reading a thread: (1) first
open the Article pane (View > Show/Hide
> Navigation Panes > Articles), left-click an
article title and select Read Article, or sim-
ple double-click an article title; or (2) place
your mouse pointer over text, if it changes
to a hand with an arrow on it, the text is
part of an article thread, simply click on it
to begin.

Navigating a thread. Once you have ini-
tiated Read Article, you can navigate
through the article thread using any of
the following methods: (1) click in an area
when the mouse is a hand icon with an ar-
row on it to move forward (shift-click to
move back); (2) press the Enter key to move
forward (or shift+Enter to move back); or
(3) the page down (or page up) keys will
also move you around within the thread.

There may be problems in getting the
hand icon with the arrow on it to ap-
pear, if this is the case, open the Prefer-
ences menu, Edit > Preferences > General,
and clear the checkbox for the item named
Make Hand tool select text & images, as
listed under Basic Tools on that dialog box.
(Ctrl+K or Command+K is the shortcut to
the Preferences dialog box on Windows
and Mac OS, respectively.)

Exploring threads. Now that you have ex-
plored the operation of article threads and
see how they work, the next thing to do is
to see how they are created with the art-
threads package.
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3. Creating article threads

We begin by including the artthreads package in your document.

\usepackage[〈options〉]{artthreads}
The artthreads package brings in the fitr package (http://ctan.org/pkg/fitr), many
commands from that package are used. In fact, the same set of package options are
used.

Package options. The package has ten options: six driver options and four viewing
options.
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Driver Options: These are dvips
(the default), dvipsone, and pdftex
(which includes the use of lualatex),
dvipdfm, dvipdfmx, and xetex. If
you specify one of the first two, it
is assumed that you are using Adobe
Distiller as your PDF creator.

The fitr package checks whether the
web package is loaded, if so, its uses
the driver used by web; otherwise
fitr auto-detects for pdftex and xe-
tex. If no driver is passed, and nei-
ther pdftex nor xetex are detected,
then dvips is the default driver.
ou’ll notice the two rectangular regions aroun
e visible by the preview option (or locally by

ers ‘precisely’ the text of the item. The outer rec
ion (or locally by \viewMagWintrue). When yo
ne an ‘extra’ border around the viewing area –
his inner rectangle may not be entirely adeq
nd the text. It is for this reason, we expand the
pare the reading comfort of the left column v

column thread with a narrow application wind
ou may have also that the viewer returns to
r to reading the thread.

article info. The specifications for an article
ptionally have key-values for author, subject, a

tThreadInfo{title=〈text〉,author=〈text〉
subject=〈text〉,keywords={〈list〉}}

o value of title is provided, artthreads uses
\setThreadInfo command must appear pr
iewing Options: When you spec-
fy preview, the bounding boxes
or the article threads are shown in
he dvi-previewer (or the PDF docu-
ent); you can turn off this preview

y specifying !preview (or remov-
ng preview entirely from the op-
ion list). The other option type is
iewMagWin, when this option the
iewing window, a rectangular re-
ion, becomes visible in the dvi-
reviewer (or in the PDF document);
pecifying !viewMagWin turns off
his type of preview.
d the left column. The inner one is
\previewtrue), you can see that it

tangle is exposed by the viewMagWin
u view the thread – and you do not
the inner rectangle is use. The text

uate for reading as it is very ‘tight’
viewing area by a specified amount.

erses the right column. (Try viewing
ow.)
the same page view the page was in

thread require it to have a title, and
nd keywords.

,

a generated value of thread-〈num〉.
ior to the opening the thread (see

http://ctan.org/pkg/fitr
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\bArticle below) to which it applies, if it does not, a LATEX error occurs. The drivers
dvips, dvipsone, xetex (dvipdfm, dvipdfmx) support all four keys; however, pdftex
only supports the title key.

The article thread commands. There is one command (\bArticle) for beginning an
article thread, and another (\cArticle) to continue that thread.

\bArticle{KV-pairs}
\cArticle{KV-pairs}

Before illustrating \bArticle and \cArticle, the KV-pairs are described first.

• width=〈length〉: The value of width sets the width of the thread to 〈length〉;
〈length〉 is usually, but not always, \linewidth. Dimension arithmetic is sup-
ported with the value of width (width=\linewidth + 3pt, for example).

• height=〈length〉: The value of height sets the height of the thread to 〈length〉.
As with the width key, dimension arithmetic is supported by height; for example,
height=3in + 2\baselineskip.

• lift=〈length〉: This key-value lifts (raises) the article thread window up (or
down) by an amount of 〈length〉; for example, lift=15pt (or lift=-15pt). The
default is a lift of 0pt. Dimension arithmetic is supported.

• shift=〈length〉: The amount of horizontal shift of the article thread; positive to
the right, negative to the left. For example, shift=-1in shifts the button/viewing
window 1 inch to the left. The default is 0pt. Dimension arithmetic is supported.

One last command before the examples.

Setting the expanded (add to) border. It is often convenient to set the basic thread
dimensions (width=\linewidth,height=3in), but is harder to expand and position
the thread to a wider or higher thread region. Use the \setAddToBorder command to
expand, or add to, the dimensions of the thread rectangular dimensions.

\setAddToBorder{addtow=〈length〉,addtoh=〈length〉}

The addtow key adds 〈length〉 to the left and right sides of the rectangular boundary of
the thread; addtoh adds 〈length〉 to the top and bottom of the rectangular boundary
of the thread. The default dimensions for these two keys are 0pt.
\setAddToBorder{addtow=10bp,
addtoh=10bp}

In this column we’ve set a 10bp border
around the thread. When you click on the
reading area, the viewer should zoom to
the width of the wider rectangle.

\
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Tip: The values of addtow and addtoh shou
as these are converted to Postscript or PDF
setAddToBorder{addtow=4bp,
addtoh=4bp}

In this column, we’ve set a 4bp border.
gain, when you click on the reading area,

he viewer should zoom to the width of the
ider rectangle.
ld be in big points (bp) for greater accuracy
dimensions, depending on the driver.
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Methodology with examples. Now we’ve come to final part of this documentation, a
description of the methodology, accompanied by examples. As pointed out early in this
documentation, the method for applying the article threads is very visual. Compose
your document content first, and then insert the document threads. Page 5

We illustrate the techniques in a single column of goodly width.
First we declare our add to border dimension and article info

\setAddToBorder{addtow=4bp,addtoh=4bp}
\setThreadInfo{title=Methodology,author=D. P. Story}

There are two places to begin a thread: (1) at the very beginning of a
paragraph; and (2) from within a paragraph. Method (1) is preferred.
We begin the next paragraph with

\noindent\bArticle{lift=\baselineskip,
width=\linewidth,height=1in+3\baselineskip}%

Now we begin our deep thoughts...
Now we begin our deep thoughts. During this development phase,
the options preview and viewMagWin should be in effect. In a DVI
viewer, we can see the bounding rectangles. We can see its too low,
too long and so on. For users of pdflatex, xelatex, etc., view your
documents in the DVI previewer first (or view them as a PDF). I’ve used
lift=\baselineskip to raise up the thread rectangle by that mount
to enclose the first line. The value of width is usually \linewidth,
but the value of height may have to be adjusted, in this example, I’ve
“tweaked” the 1in by 3\baselineskip.
Naturally, after you’re satisfied, you then remove preview and
viewMagWin or change them to !preview and !viewMagWin. Another
possible location is from within a paragraph, here, we continue the
previous thread using the \cArticle command in conjunction with
the \vadjust TEX primitive. Between the end of the word ‘primitive’
and the period (.) ending the sentence, I’ve place

primitive\vadjust{\noindent\cArticle{lift=5\baselineskip,
width=\linewidth,height=2in+\baselineskip}}. Between the

The value of lift=5\baselineskip we chosen because the original
positioning of the thread rectangle was too low by about five lines. The
value of height was chosen to cover the paragraph once the complete
paragraph was composed.
We now declare \previewfalse\viewMagWinfalse.
Of course, in this example, it was entirely unnecessary to insert

the \cArticle mid-paragraph, it would have been better placed at
the beginning of the paragraph. Placing \cArticle mid-paragraph is
useful for multi-column formats. When the paragraph flows from the
first column the second column, use the \vadjust technique to cover
the portion of the text that flows to the right column.
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By the way, notice the use of \noindent, this is oftentimes needed to position the
article thread in the left margin of the text block.

The demo file. The demo file article_tech.tex reproduces the discussion on meth-
ods, it is found in the examples folder.

In this documentation, I’ve covered the content with many article threads; normally,
for multi-column content, one thread per column is sufficient.
Nam dui ligula, fringilla a, euismod so-
dales, sollicitudin vel, wisi. Morbi auc-
tor lorem non justo. Nam lacus libero,
pretium at, lobortis vitae, ultricies et, tel-
lus. Donec aliquet, tortor sed accumsan
bibendum, erat ligula aliquet magna, vi-
tae ornare odio metus a mi. Morbi ac
orci et nisl hendrerit mollis. Suspendisse
ut massa. Cras nec ante. Pellentesque
a nulla. Cum sociis natoque penatibus
et magnis dis parturient montes, nasce-
tur ridiculus mus. Aliquam tincidunt urna.
Nulla ullamcorper vestibulum turpis. Pel-
lentesque cursus luctus mauris.

Quisque ullamcorper placerat ipsum.
Cras nibh. Morbi vel justo vitae lacus tin-
cidunt ultrices. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit. In hac
habitasse platea dictumst. Integer tempus
convallis augue. Etiam facilisis. Nunc el-
ementum fermentum wisi. Aenean plac-
erat. Ut imperdiet, enim sed gravida sol-
licitudin, felis odio placerat quam, ac pul-
vinar elit purus eget enim. Nunc vitae tor-
tor. Proin tempus nibh sit amet nisl. Viva-
mus quis tortor vitae risus porta vehicula.

Suspendisse vel felis. Ut lorem lorem,
interdum eu, tincidunt sit amet, laoreet vi-
tae, arcu. Aenean faucibus pede eu ante.
Praesent enim elit, rutrum at, molestie
non, nonummy vel, nisl. Ut lectus eros,
malesuada sit amet, fermentum eu, so-
dales cursus, magna. Donec eu purus.
Quisque vehicula, urna sed ultricies auc-
tor, pede lorem egestas dui, et convallis
elit erat sed nulla. Donec luctus. Curabitur
et nunc. Aliquam dolor odio, commodo
pretium, ultricies non, pharetra in, velit.
Integer arcu est, nonummy in, fermentum
faucibus, egestas vel, odio.

Sed commodo posuere pede. Mauris ut
est. Ut quis purus. Sed ac odio. Sed vehic-
ula hendrerit sem. Duis non odio. Morbi ut
dui. Sed accumsan risus eget odio. In hac
habitasse platea dictumst. Pellentesque
non elit. Fusce sed justo eu urna porta
tincidunt. Mauris felis odio, sollicitudin
sed, volutpat a, ornare ac, erat. Morbi quis
dolor. Donec pellentesque, erat ac sagit-
tis semper, nunc dui lobortis purus, quis
congue purus metus ultricies tellus. Proin
et quam. Class aptent taciti sociosqu ad
litora torquent per conubia nostra, per in-
ceptos hymenaeos. Praesent sapien turpis,
fermentum vel, eleifend faucibus, vehicula
eu, lacus.

Suspendisse vitae elit. Aliquam arcu
neque, ornare in, ullamcorper quis, com-
modo eu, libero. Fusce sagittis erat at erat
tristique mollis. Maecenas sapien libero,
molestie et, lobortis in, sodales eget, dui.
Morbi ultrices rutrum lorem. Nam ele-
mentum ullamcorper leo. Morbi dui. Ali-
quam sagittis. Nunc placerat. Pellen-
tesque tristique sodales est. Maecenas im-
perdiet lacinia velit. Cras non urna. Morbi
eros pede, suscipit ac, varius vel, egestas
non, eros. Praesent malesuada, diam id
pretium elementum, eros sem dictum tor-
tor, vel consectetuer odio sem sed wisi.

Etiam euismod. Fusce facilisis lacinia
dui. Suspendisse potenti. In mi erat,
cursus id, nonummy sed, ullamcorper
eget, sapien. Praesent pretium, magna in
eleifend egestas, pede pede pretium lorem,
quis consectetuer tortor sapien facilisis
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4. My retir
magna. Mauris quis magna varius nulla
scelerisque imperdiet. Aliquam non quam.
Aliquam porttitor quam a lacus. Prae-
sent vel arcu ut tortor cursus volutpat. In
vitae pede quis diam bibendum placerat.
Fusce elementum convallis neque. Sed do-
lor orci, scelerisque ac, dapibus nec, ul-
tricies ut, mi. Duis nec dui quis leo sagittis
commodo.

Etiam ac leo a risus tristique nonummy.
Donec dignissim tincidunt nulla. Vestibu-
lum rhoncus molestie odio. Sed lobortis,
justo et pretium lobortis, mauris turpis
condimentum augue, nec ultricies nibh
arcu pretium enim. Nunc purus neque,
placerat id, imperdiet sed, pellentesque
nec, nisl. Vestibulum imperdiet neque non
sem accumsan laoreet. In hac habitasse
platea dictumst. Etiam condimentum fa-
cilisis libero. Suspendisse in elit quis
nisl aliquam dapibus. Pellentesque auc-
tor sapien. Sed egestas sapien nec lec-
tus. Pellentesque vel dui vel neque biben-
The demo file. The demo file for this pack
examples folder.

ement

Now, I simply must get back to it. DPS
dum viverra. Aliquam porttitor nisl nec
pede. Proin mattis libero vel turpis. Donec
rutrum mauris et libero. Proin euismod
porta felis. Nam lobortis, metus quis el-
ementum commodo, nunc lectus elemen-
tum mauris, eget vulputate ligula tellus eu
neque. Vivamus eu dolor.

Nulla mattis luctus nulla. Duis com-
modo velit at leo. Aliquam vulputate
magna et leo. Nam vestibulum ullamcor-
per leo. Vestibulum condimentum rutrum
mauris. Donec id mauris. Morbi mo-
lestie justo et pede. Vivamus eget turpis
sed nisl cursus tempor. Curabitur mollis
sapien condimentum nunc. In wisi nisl,
malesuada at, dignissim sit amet, lobor-
tis in, odio. Aenean consequat arcu a
ante. Pellentesque porta elit sit amet orci.
Etiam at turpis nec elit ultricies imperdiet.
Nulla facilisi. In hac habitasse platea dic-
tumst. Suspendisse viverra aliquam risus.
Nullam pede justo, molestie nonummy,
scelerisque eu, facilisis vel, arcu.
age is article_tst.tex, available in the
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